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Annual “Ask the Guru” Night

Once again it’s time for our annual “Ask the Gurus” night

where you get the chance to bring your questions to a panel of

knowledgeable people who will attempt to demystify the

computer for you. No matter what your question might be,

the panel will attempt to give you a satisfactory answer.

Smart Computing Offers
Free “Help Service”
This is a repeat of an article that appeared in a
previous issue of Explorer.

Try out this remarkable op-
portunity to obtain free techni-
cal support courtesy of Smart
Computing. It’s something new
they are offering to both sub-
scribers and non-subscribers.  

They provide free tech sup-
port for anyone!  So share this
info with family and friends. 

Call Smart Computing repre-
sentatives at 800-368-8304 and
they'll provide answers to com-
puting questions at no charge!  

If you have any questions
about this or any of the other
benefits offered by this com-
pany feel free to call them at
their 800 number.

Bob Schaffer, your Explorer
editor, is very interested in hear-
ing about your experiences with
this free tech support service. 

Email:  rdschaffer@adelphia.net
Phone: 853-5984 �

Meeting Agenda

5:30 . . . . . . . . Meet and Greet

6:00 . . . . . . Business Meeting

6:30 . . . . . . . . Program, Part 1

7:00 . . . . . . . . . . . . . . . . Break

7:15 . . . . . . . . Program, Part 2

8:15 . . . . . Drawing for Prizes

8:30 . . . . . . . . . . Adjournment

Bring your questions to our panel of experts . . .
• Lisa Britt — Vice President/software-hardware
• Bill Gorrell — Treasurer/hardware
• Joe Madeira — Past President/software

NOTICE:  This meeting will be held at the Utica
Maennerchor Hall, 108 Flanagan Rd, Marcy.
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The MVPCUG EXPLORER is published

monthly from September through June by the

Mohawk Valley Personal Computer User Group,

Inc., PO Box 586, Marcy NY 1403-0586.

Opinions expressed herein are the writers and

are not reflective of the MVPCUG, nor are they

considered substantiated by inclusion in this

newsletter. All articles are copyrighted by their

respective authors but may be reprinted by other

User Groups provided credit is given to the author

and this publication.

The Mohawk Valley PC User Group, Inc.

(MVPCUG) was founded in 1981 by individuals

interested in IBM compatible computers. This non-

profit organization consists of volunteers whose

expertise range from novice to professional.

Regular meetings are held on the first Tuesday

of the month at 6pm, usually at the Whitesboro

High School, Route 291, Marcy NY. A typical

agenda consists of discussion of business affairs

and a demonstration of computer related products.

Meetings are open to the public.

Initial membership fee for an individual is $25.

Annual renewal dues are $20.

NEWSLETTER STAFF
Editor

Bob Schaffer

Columnists

Jerry Finkelstein
Donna Gorrell
John Hunter

The Explorer is printed by

The Gallery
4780 Commercial Drive - New Hartford

   315-768-7851

Our Internet presence is at

http://www.mvpcug.com

The Web Team
Dan Evans
Lisa Britt

ADVERTISING RATES

¼  page — $25   e   ½  page — $45

HELP HOTLINES
Help is limited to times indicated:

w Day calls: 9am to 4pm. 

w Evening calls: 6 to 9pm. 

If your problem isn’t urgent, please try email.

Disclaimer: The individuals listed here provide
voluntary services and information. Please be
considerate when you call. Our Help Hotline
members reserve the right to limit the amount of
advice and number of calls they will accept. Use
these services and information at your own
discretion and risk as they and the MVPCUG do
not assume responsibility for any software or
hardware failures that may occur. The club does
not assume responsibility for any agreements
made by participating parties.

AOL
. . . . . . . . . . . . . . . . . . . . . . . . . . Dave Askew

Batch Files
. . . . . . . . . . . . . . . . . . . . . . . . Tim Clinehens

Excel
. . . . . . . . . . . . . . . . . . . . . . . . . . . . Bob May

Money
. . . . . . . . . . . . . . . . . . . . . . . . . Bob Schaffer

Troubleshooting
. . . . . . . . . . . . . . . . . . . . . . . . Tim Clinehens
. . . . . . . . . . . . . . . . . . . . . . . . . . . Bill Gorrell

WordPerfect
. . . . . . . . . . . . . . . . . . . . . . . . . Bob Schaffer

OFFICERS AND DIRECTORS

President
. . . . . . . . . . . . . . . . . . Jerry Finkelstein

Vice President
. . . . . . . . . . . . . . . . . . . . . . . . . Lisa Britt

Treasurer
. . . . . . . . . . . . . . . . . . . . . . . Bill Gorrell

Secretary
. . . . . . . . . . . . . . . . . . . Marsha Thayer

Directors-at-Large

. . . . . . . . . . . . . . . . . Dave Askew [‘05]

. . . . . . . . . . . . . . . George Bracken [‘06

. . . . . . . . . . . . . . . . . . Bob Schaffer [‘07

Smart Computing Special
MVPCUG members can now enjoy special

benefits and pricing from the publishers of Smart
Computing, CPU, PC Today, and CE Tips.
Subscribe to one magazine and have access
online to all four publications!
i Smart Computing — For all skill levels, the

plain-English writing style will help you
improve your PC productivity and get the
most out of your computer. For more info,
visit www.smartcomputing.com.

i Computer Power User — For the high-end
power user with a taste for cutting-edge
products and for those who enjoy the
challenge of mastering and implementing
new technologies.  For more info, visit
www.computerpoweruser.com.

i PC Today — Filled with practical Windows
advice that PC users can put to work
immediately. Step-by-step tutorials, the
latest operating system news, hardware and
software reviews, and PC gaming. For more
info, visit www.pctoday.com.

i CE Tips — Covers the world of consumer
electronics from HDTV to your digital
camera. For more info:  www.cetips.com. 

For every five paid subscriptions MVPCUG
will receive a free subscription. Members family
and friends can order subscriptions . The unique
code numbers to use when calling (800)
733-3809 to order are:
i Smart Computing: 12659
i CPU: 935
i PC Today: 570
i CE Tips: 415

GET A FREE MVPCUG MEMBERSHIP

� It’s easy to do and you’ll save $20.00!

� Just sign up two new members and you
receive a one-year membership extension.

� You have 90 days in which to sign up your
two new members.
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The MVPCUG general meeting was held at the Whitesboro

High School. President Jerry Finkelstein called the meeting to

order at 6:06 PM.

Business Meeting
There will be no general meeting in July and August.
The September meeting place is under investigation.
The club membership will be informed by e-mail and
by Newsletter. The Newsletter will not be printed in
July and August.

A Utility CD Survey is available for folks to fill
out. Tim created the survey to find out what people
want on CDs. Tim announced that those that fill out a
survey would get a free CD. However, since the
Board has not discussed this and it involves expense
on the part of the club, free CDs are not available.

We are now creating CDs for the club at no cost
(a quantity of 7 per month). We voted to charge $3.00
for the Utility CDs (both old ones and new ones).

The Treasurer’s Report for May shows $237.91 in
income and $241.81 in expenses with a balance of
$4629.21.   For the June Newsletter we printed 225
copies.  In the Fall that will be reduced to 175 copies.

Bill reported on the results of survey for the
on-line versus printed copy Newsletter.
* There was a total of 61 responses out of 134

e-mails sent.
* Response to the On-line vs. Printed copy question:

44 satisfied with on-line Newsletter; 17 would
prefer paper.  

* Would you discontinue your membership if only
on-line Newsletter was available? 4 yes; 43 no; 3
possible.

* Would you be willing to pay more dues for a hard
copy Newsletter? 19 yes; 6 yes if limited to $5.00;
26 no.

Beware of e-mail from IRS.  It’s probably bogus.
Question: What’s the difference between .net and
.com? Answer: We’re not sure. A lot of Internet Ser-
vice Providers use .net.

What sort of presentations would the club mem-
bers like to see for the meetings starting in the Fall? 
* Word Perfect  (Donna said the company would

not come out for a presentation).
* Web Conferencing
* Computer security & encryption

* Spyware and AntiSpyware

* Photoshop
* Use the computer to make phone calls over the

internet
* Wireless networking
* Networking in general
* HTML - Java Script

Program
At 6:50 the main program began. Jeff Berman from
Syracuse presented a program on Digital Photogra-
phy, “Digipics 101". He teaches a digital camera class
at OASIS. (See www.oasis.org or call 315-464-6555).
Jeff can be reached at 372-4628.
Jeff  recommended the following software related to
digital photography:
* To view full sized pictures: ACDSee 6.0;

www.acdsee.com; $49.99
* To edit photos: Ulead Photo Impact XL;

www.ulead.com; $89.95
* To print pictures: Arc Soft Photo Printer; 

www.arcsoft.com; $39.95
* To create a photo album: Flip Album;

www.flipalbum.com; $19.99
* To store pictures on a server: www.ofoto.com;

free
Jeff recommended the following web sites for digital
photography:
* For information: www.shortcourses.com
* For reviews: www.epinions.com
* For reviews and cheapest prices: shopper.com
* For camera information: stevesdigicams.com
* For camera memory: www.newegg.com
* For cheap lithium batteries: sabahoceanic.com
At 8:40 we drew door prizes.

Door Prize Drawing Winners
(The following prizes furnished with club funds)

10-pack CDRs with cases . . . . . . . . . . Joe Madeira
15-pack CDRs with cases . . . . . . Robert McMillan
CD label paper . . . . . . . . . . . . . . . . . . Howard Estey
PCI sound card . . . . . . . . . . . . . . . . . . . . . Dan Evans
Neato CD/DVD Labeling System . . . . John Hunter

(The following prizes furnished by Judy Wenner)

Norton Antivirus 2004 . . . . . . . . . . . . . Dave Askew
(The following prizes furnished by Jerry Finkelstein)

24 pack Postits . . . . . . . . . . . . . . . . . . . . . Ray Tryon
Book: Using HTML4 . . . . . . . . . . . . . . . . . Stu Culp

The meeting was adjourned at 8:45  p.m.

Respectfully submitted,

Marsha Thayer, secretary �

Minutes of June 1, 2004

— Marsha Thayer, Secretary  

http://www.oasis.org
http://www.acdsee.com
http://www.ulead.com
http://www.arcsoft.com
http://www.flipalbum.com
http://www.ofoto.com
http://www.shortcourses.com
http://www.epinions.com
http://www.shopper.com
http://www.stevesdigicams.com
http://www.newegg.com
http://www.sabahoceanic.com


Word Processing Tips
— by Bob Schaffer  
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WORD — Using Formatting Marks
Word’s formatting marks are not displayed by default.
However, you might want to consider displaying them
to help you better see the structure of your
documents.

For example, with all the formatting marks
displayed, you can see how many spaces there are
between words, you can see the paragraph marks, and
you can see the tabs.
To turn on the formatting mark display:
* Choose Tools/Options. 
* When the Options dialog box opens, click the View

tab. 
* Under “Formatting marks” select the check box

labeled “All.” 
* Or you can select only those check boxes that

represent the marks you want to see. 
* After you make your selection, click OK to close

the dialog box.
[Note: WordPerfect’s most often quoted point of
superiority over Word is its Reveal Codes feature. It
provides a vast number of formatting clues when
compared to Word.]

WORDPERFECT —Appending text to the

Clipboard (8/9/10/11)
If you need to copy several items from a document to
paste into another file, there’s no need to copy and
paste repeatedly. You can copy and append text to the
Clipboard, instead of replacing what’s already there.
Then, you only need to paste once into your target
document.
To append text to the Clipboard contents:
* Select the first block of text you need to copy and

select Copy from the Edit menu or press Ctrl+C. 
* Then, select the next block of text and choose

Append from the Edit menu.
* Append all the text you need, then simply paste it

into the destination document as you normally
would. �

CD COLLECTION SERIES
Each month utilities in categories such as: admin

tools, anti-virus, backup, browsers, drive cleaners,
game tweaks, mail utilities, mobile, spyware tools and
system info are collected and a CD is produced. Each
CD is packed full, 600 meg or greater. The list is too
large to print in the newsletter, however, you can find
a complete list in PDF that you can print on the
web-site at www.mvpcug.com.

Each CD in the collection is available at the general
meeting for $3.00. �

Sign up for weekly WordProcessing Tips 
to be emailed to you.

Send your request to rdschaffer@adelphia.net.

CAUTION!
Make sure you download AND

INSTALL the latest Microsoft

updates.

   It has been advised by many knowledgeable
computer specialists that Internet Explorer is
extremely vulnerable to security leaks. The
gurus advise that you install a different
browser to keep your computer safe. 
   Netscape, Mozilla, and Opera are just a
few of the choices that you can make. All can
be downloaded for free.

http://www.mvpcug.com
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. . . .that you can add buttons to the Links or Personal
Toolbar of your Internet browser? In Internet
Explorer, this toolbar is called the Links bar, which is
situated in the upper-left corner of your browser
window. If it’s not on your toolbar, you can select
View | Toolbars | Links and make sure that Links is
checked by selecting it from the menu. To add a site
as a button to the Links bar, click any link to that site,
then drag and drop it onto the Links bar.
. . . In Netscape, you can add buttons to the Personal
Toolbar located below the Location and Navigation
Toolbars at the top of the browser window. If the
toolbar isn’t showing, select View | Toolbars |
Personal Toolbar and select Personal Toolbar from
the menu. To add a button to the Personal Toolbar
simply drag and drop the URL from the address bar to
the Personal Toolbar.

                    *               *               *
. . . that when you copy something from the Web or
another document and then try to paste into Word or
WordPerfect, the formatting, tables, and other
unwanted items are also copied? Pasting will also
copy the font and size into the new document. To
prevent this from happening, choose Edit from the
menu and then Paste Special. Use the Unformatted
Text option to insert only text without other items or
the original fonts.

                    *               *               *
. . . that you can use the keyboard to shutdown the
computer?  Press Alt+F4; the Shut Down Windows
dialog box will appear.  Press U or click on
Shutdown. Pressing Ctrl+Alt+Delete will also bring
up a window that will show you what is running and is
handy to close a program when it stops responding or
hangs up your computer.  Pressing Ctrl+Alt+Delete a
second time will bring up the shutdown dialog box.

                    *               *               *
. . . that you can keep a diary of all the automatic
installs that you’ve done (from Microsoft) along with
a record of all your other installed programs? From
the Start Menu, select “Windows Update” icon. Once
in Microsoft’s site, select “Installation History”. Go to

http://windowsupdate.microsoft.com/default2.html
follow the links to “Product Updates”, then
“Installation History”. Cut and paste this information
to your word processor by selecting All (Ctrl A), then
Copy (Ctrl C). Start your word processor and Paste
(Ctrl V), saving as Program History. You can then
edit the file and remove all extraneous graphics, etc.
Insert the date so you will have a dated record of the
program updates.

                    *               *               *
. . . that you can use the keyboard instead of mouse
for right-click menus? Press Shift-F10.  This will pop
up the right-click menu. Once the menu is displayed,
use the arrow keys to navigate to the option you want,
press Enter or the shortcut letter key (the underlined
letter in each menu option).

                    *               *               *
. . . that browsers keep a record of the web pages you
visit in a history list? To open your history in Internet
Explorer, click the History button in the toolbar. In
Netscape, type Ctrl-H. Once the history window
appears, double click a page to view it in your
browser.

                    *               *               *
. . . that when you want to send the same email to a
number of people but do not want them to see each
other’s email address, and thus to keep the addresses
private, you can use the BCC: field? This means Blind
Carbon Copy. Each person on the list will get a copy
of the email but will only see his own address, no one
else’s address will appear. Most email programs will
allow you to leave the To: field empty and
Undisclosed Recipients will be inserted in this field.
However, some older programs will display the whole
BCC list when you leave the To: field empty. To
avoid this problem simply enter your own address in
the To: field.
     All email programs have a BCC field, but you may
have to search for it. In Outlook, if BCC isn’t
showing, create a message and from the View menu,
click BCC Field. In Outlook Express, click View>>All
Headers. IN Netscape, click the To button, then
double-click BCC. In AOL, put the BCC addresses in
the Copy To Box, using parentheses. In Eudora, just
put the addresses in the BCC line separating them with
a comma. �

   Did You Know . . . 
— Donna Gorrell    

http://(http://windowsupdate.microsoft.com/default2.html
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On the next to the last day of June I am at my
computer wondering what to write about that will be
relevant when you read this during the last week of
August. By the end of August, both major political
parties will have had their respective nominating
conventions with the likely candidates being President
George W. Bush and Senator John Kerry.

To start, I googled “democrats” and immediately
received a list of 4,280,000 web sites. I then typed in
“republicans” and received 2,830,000 web sites
connected to the word republican. Democratic web
sites outnumber Republican sites by 1.4 million. I have
no idea what the significance of this statistic is, but the
Democrats seem to be more active in this regard than
the Republicans.

I clicked on the Democratic National Committee
web site, the first one on the list. There are the
inevitable statistics provided that trumpet the
purported failures of the Bush administration. The site
also provides individuals the opportunity to sign up
for email announcements. And, the site provides at
least three ways to contribute money. Surprise. Anti-
Bush cartoons are posted daily for those interested in
Bush bashing.

On the Republican National Committee web site,
you find the same kinds of items only the bad guys are
the Dems. No surprise. And the site provides a Flog or
Fact Log. This link offers answers to Democratic
charges of unemployment increases, manufacturing
job losses, outsourcing, and boasts of the positive
effect produced by the most recent tax cuts. All very
predictable. Like the Democrats, Republicans offer
many ways for individuals to donate to the campaign.

The Green Party web site is reminiscent of the
counter culture of the 1960s. The Green Party
affiliates with similar groups worldwide. That
probably accounts for the fact that Google reports
7,670,000 web sites for this group. A news post
announces that David Cobb rather than Ralph Nader
received the party nomination for president at their
convention on June 25. Like the two major parties, the
Green Party offers opportunities for those who
support them to donate money. One interesting aspect
of the site, however, provides specific tools for
organizing at the grassroots level. Talking points are

provided on grassroots democracy, social justice,
ecological wisdom, non-violence, decentralization, and
so on. Yada, yada. Just like 1968 and 1972.

The Socialist Party USA, www.sp-usa.org, is much
smaller than the parties listed above. Google reports
only 236,000 web sites for this group. According to
the web site, the party nominated Walt Brown and
Mary Alice Herbert for president and vice president
respectively. This site is much more issue oriented
than some of the others with concerns about civil
rights and civil liberties and anti-detention
demonstrations to free the detainees in Cuba with a
link to www.freethedetainees.org. Also listed are a
number of conferences scheduled for the summer. The
party is celebrating 100 years of ineffective social
activism this year and though small, is long-lived.

Another interesting site is the Yahoo Directory of
political parties at http://tinyurl.com/3hmx5. The list
begins with the America First Party followed by
America’s Party, The American Conservative Party,
the American Reform Party, Christian Alliance,
Communist Party USA, Confederate Party of
America, all the way down to the Workers World
Party and Young Democratic Socialists.

The most interesting site on this directory is
www.politics1.com/parties.htm. This site provides a
very complete listing of political parties and the
candidates and/or political ideas they espouse. The
party descriptions are factual and appear unbiased.
The site purports to be the “most comprehensive
guide to American politics on the web.” In addition to
descriptions of political parties, the site provides a
cornucopia of other topics for the political junky. You
can surf state and national candidate lists, political
parties calendar, campaign products/services, issues,
blog archives, campaign buttons [for all the collectors
out there], and so on.

If by now you are at the point of sticking your head
in a bucket of beer and ignoring politics altogether,
here are several other sites to consider. With the
recent focus on raising reading and math scores in
public schools, art, music and social studies programs
in many places have been cut. California teachers,
however, will soon be able to strengthen these
subjects by linking curricula to a renowned museum
collection.

A $210,000 donation from Mouli Cohen, a San
Francisco philanthropist and biotechnology

(continued on page 7)

  Sites to Visit on the ‘Net
— by John Hunter   

http://www.sp-usa.org
http://www.freethedetainees.org
http://www.yahoo.com/Government/U_S_Government/Politics/Parties
http://tinyurl.com/3hmx5
http://www.politics1.com/parties.htm
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(Sites . . . continued from page 6)
entrepreneur, will pay for a series of curriculum guides
for grades 1 through 12 produced by the Fine Arts
Museums of San Francisco, reports Education Week.
The guides will feature lessons related to the
collections of the newly renovated de Young Museum,
the city’s oldest. The guides, entitled “Get Smart With
Art at the de Young”, will be available for free on line.
For more information, click on www.thinker.org. The
guides will be available in October 2005. Maybe
something like this could happen at Munson Williams
in Utica. It’s just a thought.

For those suffering morbid thoughts brought on by
the political season, go to  www.asylumeclectica.com.
The homepage for this site features a picture of a very
spooky old building with a list of topics to pursue such
as: Morbid Fact Du Jour, All things Dark and
Gruesome, and The Morbid Sightseer . . . just to name
three. I clicked on The Morbid Sightseer and found a
list entitled The United States of Morbidity. Not all of
the states have links at this time, but if you click on
one of the available links—Idaho, for example—there
is a link to the Old Idaho State Penitentiary, built in
1870 and in use until 1973. This link is actually a
travel guide for the restored penitentiary which can be
toured 10 am to 5 pm daily from Memorial Day to
Labor Day. The site is actually interesting and
informative and will appeal to tourists seeking an
unusual experience.

The other Idaho link goes to Massacre Rocks at
American Falls. This web site for the Oregon Trail
commemorates a skirmish between Indians and settlers
in 1862 during which 10 settlers died. History buffs
should enjoy clicking on this. Until next month . . . �

Welcome back from your vacations, from your
summer holidays, your time off from your usual life,
and your summer days of catching up with whatever
you had let go all year long for tune up.

Time for a PC tune up? Interested in helping out
the economy and getting yourself a brand new, but
relatively inexpensive, computer? Interested in the
next new thing? The new camcorders are featuring
straight to DVD technology. The various camcorders
offer different features, for about the same buck. You
might want to do some serious checking before
buying. Laser color printers have come way down in
prices. Grayscale need not be your only financially
affordable option. How often have we complained
about spending cheap for the inkjet printer but getting
hit hard on the expense for the cartridge. The toner
prices may seem expensive, depending on the printer,
but the laser printer toner lasts longer than the ink jet
cartridge and page by page it is the laser product that
is less expensive.

Business news and computer magazines have been
sounding the death knell for tape cassettes. We are
being alerted to their death and burial in five years.
Yes, five years is the time frame that is being men-
tioned. So, if you have tons of cassettes stacked away
with your other priceless stuff, you might want to start
now transferring them to CDs or DVDs. Well, maybe
not to the ordinary, currently used CD and DVD. 

Already available and ready to knock these two
storage media disks off its popular track is the double
layered DVD. The advantage of this new DVD is that
it doubles, at least, the storage capacity of the DVD.
You’ll know it by the DL added to the DVD-R pack-
aging. And you thought you were being smart buying
up hundreds of blank DVDs on recent sales, hoarding
them so that you’d be able to back up your movies on
the cheap for years to come. Well, if you are feeling
generous we can always use them as club door prizes. 

Longhorn, the next Windows OS is just around the
corner; it’s already being reviewed. Do I hold off
buying my next home computer until it’s on the
market? Of course not, I’ll buy now while the prices
are hot. They’re always hot. And by the way, I help
the economy. �

    Byting Remarks
— Jerry Finkelstein    

Don’t forget!
September 7th

General Meeting 

will be held at the

Utica Maennerchor Hall

 108 Flanagan Road

Marcy

http://www.thinker.org
http://www.asylumeclectica.com
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